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1. General

1.1 Purpose

The purpose of this document is to define the interface between a Transcoding Server and any application wishing to make use of the transcoding service, but focusing the Multimedia Messaging Service Environment (MMSE, see [11]).

This document describes scenarios and requirements to support the definition of the above-mentioned interface.

This interface will be proposed to the 3GPP, as Philips and its partners are committed to the use of open standards.

Please note that this is a DRAFT version of the interface, and is subject to changes without notice.

1.2 Audience

This document is targeted at the developers of Transcoding Servers and Multimedia Messaging Service Centers (MMSCs) to make their systems compliant to this interface, and to application developers who would like to use the transcoding service.

1.3 Scope

The scope of this document is limited to the normative and informative definition and reference of a transcoding interface between an application and a generic Transcoding Server. It describes some of the scenarios and the requirements leading towards the definition of the interface. Furthermore, a number of interface exchange examples are presented.

1.4 Document overview

Section 2 describes the general features that are supported by the transcoding interface.

Section 5 describes, in details, the request structure and contents, where Section 6 does the same for the response.

Annex A contains examples of requests and Annex B of responses.

1.5 Notational information

The keywords “MUST”, “MUST NOT”, REQUIRED”, “SHALL”, “SHALL NOT”, “SHOULD”, “SHOULD NOT”, “RECOMMENDED, “MAY” and “OPTIONAL” in this document are to be interpreted as described in RFC2119 (see [12]).

1.6 Definitions

Message – A piece of information communicated over a channel, in this case used as a generic term.

Multimedia Message – A well-defined type of message as used in the 3GPP specifications (see [11]).

Transcoding Job – An ‘atomic’ job for the transcoder, i.e. a specification containing only a single media reference and the parameters required for the transcoding of this media only.

Transaction – A list of Requests, i.e. an XML tag containing several Requests.

Request – A single request, i.e. an XML tag referring to a Transcoding Job.

Transcoding Server – A component that can receive requests for media (or bigger chunks) to be transcoded (e.g. reformatted or resized) and send back responses with the result(s).

1.7 Abbreviations

	ASCII
	American Standard Code for Information Interchange

	E-Mail
	Electronic Mail

	FTP
	File Transfer Protocol

	HTTP
	Hypertext Transfer Protocol

	MIME
	Multipurpose Internet Mail Extensions

	MM
	Multimedia Message

	MMS
	Multimedia Messaging Service

	MMSC
	Multimedia Messaging Service Center

	SMIL
	Synchronized Multimedia Integration Language

	SOAP
	Simple Object Access Protocol

	URL
	Uniform Resource Locator

	UTF
	Unicode Translation Format

	WAP
	Wireless Application Protocol

	XML
	Extensible Markup Language


1.8 References

[1] SOAP v1.1: http://www.w3.org/TR/SOAP/
[2] RFC2616: HTTP v1.1: http://www.w3.org/Protocols/rfc2616/rfc2616.html
[3] RFC2045: MIME, Part One: Format of Internet Message Bodies: http://www.ietf.org/rfc/rfc2045.txt
[4] RFC2046: MIME, Part Two: Media Types: http://www.ietf.org/rfc/rfc2046.txt
[5] RFC2047: MIME, Part Three: Message Header Extensions for Non-ASCII-Text: http://www.ietf.org/rfc/tfc2047.txt
[6] RFC2048: MIME, Part Four: Registration Procedures: http://www.ietf.org/rfc/tfc2048.txt
[7] RFC2049: MIME, Part Five: Conformance Criteria and Examples: http://www.ietf.org/rfc/tfc2049.txt
[8] RFC2387: The MIME Multipart/Related Content-Type: http://www.ietf.org/rfc/rfc2387.txt
[9] RFC2279: UTF-8, a transformation format of ISO 10646
[10] RFC2376: XML Media Type: http://www.ietf.org/rfc/tfc2376.txt
[11] 3GPP Technical Specification Group Terminals; Multimedia Messaging Service (MMS); Functional description; Stage 2 (Release 5); e.g.: http://www.3gpp.org/ftp/Specs/latest/Rel-5/23_series/23140-530.zip
[12] RFC2119: Key words for use in RFCs to indicate requirement levels

[13] SOAP Messages with Attachments: http://www.w3.org/TR/SOAP-attachments
[14] RFC2327: SDP – Session Description Protocol: http://www.ietf.org/rfc/rfc2327.txt
[15] WAP User Agent Profiling (UAProf): http://www1.wapforum.org/tech/documents/WAP-248-UAProf-20011020-a.pdf
2. Transcoding

Transcoding is understood to be the process of accepting an input (media) format, which may be one but not limited to a graphical, audio or video format, and perform a specified transformation on that input and return the result to the caller.

Depending on the requesting application, the formats might be expanded with other types, as such is the case within an MMSE, where the Multimedia Message (MM) type can be added for convenience; this multimedia message may consist of a number of different attachments whereby the presentation can be controlled by a SMIL attachment. In this specific case, the contents of the MM might need to be transcoded to comply with the characteristics of the receiving device. It could be left up to the application or the Transcoding Server to decide whether or not to transcode the content.

2.1 Scenario definitions

In order to get a common understanding of transcoding and the resulting requirements, some scenarios have been defined.

2.1.1 Generic transcoding scenario

Figure 1 General transcoding scenario
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A general transcoding scenario at the application layer is presented in Figure 1. An application, via its business rules, has come to the conclusion that transcoding of content is required. The application will then post a transcoding request to the transcoder, supplying the content and the actions required on that content. The transcoder will in its turn accept the request and content, process it according to the specifications supplied within the request and consequently return the result of the processing request back to the requesting application. This is the basic transcoding scenario.

2.1.2 SAN based transcoding

The second transcoding scenario is where the application and the transcoder share common storage via a separate transport medium, such as would be the case where Storage Area Network (SAN) technology is deployed.

Figure 2 SAN transcoding scenario
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An example of such a scenario is depicted in Figure 2. In this case, the data itself is not transported across the normal network. The application will send a request to the transcoder, supplying the actions required, the source object URI and target object URI. The transcoder will then access the source object via the SAN, perform the transcoding and place the result of the transcoding on the target URI. The transcoder will then respond back to the application with the response codes and statistical data.

The model whereby the data is included in the request and where one transcoding request may consist of one of more individual requests is deemed to be the most efficient and flexible form in general.

2.2 Streaming Server scenario

Figure 3 Streaming media scenario
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Besides media parts that can be downloaded or directly contained within (Multimedia) Messages, also streaming media should be supported by the transcoder. Figure 3 shows the typical scenario for the transcoding of streaming media. The transcoding request contains the (already streaming or not) media part which needs to be transcoded. After the transcoding, the transcoder uploads the content to a Stream Server.

2.3 A-Synchronous mode scenario

In the future, the synchronous mode as depicted above (the request is blocking waiting for the response) might not be the optimal way to interact with the Transcoding server. For example in cases where the transcoding of streaming media is involved (see the scenario above), a a-synchronous model might result in a more optimal scenario (where the application will be informed of the progress of the transcoding, instead of only the result).

Figure 4 A-synchronous mode request and response
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 shows the typical scenario of asynchronous requests and responses.

Please note that multiple responses can follow a single request and that this is not the current preferred model, since it requires keeping state information about the transcoding box, which is not optimal in a distributed fault-tolerant environment.

3. Requirements

The transcoding interface must conform to a number of requirements. These requirements are generally understood principles of interface definitions and specific transcoding requirements from the above described scenarios.

3.1 Generic requirements

The high level requirements are as follows:

I. The interface defined here shall be a basic framework within which the requirements that follow can be accommodated.

II. The interface shall be based on publicly available open standards free of IPR.

III. The interface shall be readily extensible with a minimum of effort and change.

IV. The interface shall be flexible in the models offered for achieving the required goals and supporting a broad spectrum of models. Specifically, a wide spectrum of implementations should be supported within the context of the application.

V. The interface shall be a lightweight protocol incurring a minimum of overhead

VI. The interface shall reuse tried and tested technology where possible.

VII. The interface shall architecturally provide the capability to scale (virtually) limitlessly.

VIII. The interface definition shall be based on a request/response messaging model using a single connection, but shall not prevent an a-synchronous messaging model for the future.

3.2 Transcoding and scenario requirements

Besides these common understood high level requirements, also additional requirements have been identified from the transcoding scope of the interface and the previously described scenarios:

IX. The interface shall support media format conversion.

X. The interface shall support transformations, such as resampling and enhancements of the media.

XI. The interface shall support multiple requests within the paradigm of a single message request.

XII. The interface shall support external media references.

XIII. The interface may support streaming media.

3.3 Discussion on requirements

Of course, the interface should support the basic concepts of transcoding, i.e. format conversion and transformations (IX,X). 

The definition of the interface should provide a basic efficient framework (I) which is extensible (III) and readily accessible (II). In order to facilitate future enhancements and developments and support a multitude of hosts and peers with different capabilities, it should not be limited to a singular model (IV) but rather provide the capability to be expanded to other models. Obviously performance is an important determining factor, so the interface should be as lightweight as possible (V). However, reusing tried and tested technology has the advantage of cutting development and testing time for all parties involved, making the solution more robust and accelerating the time to market factor (VI). Cutting overhead increases performance thus leads to the requirement that multiple requests should be possible within the context of a single message (XI). Performance is also related to scaling factors (VII). Implementing a model that supports a distributed model (VIII) would be far more preferable to one requiring state information which would unnecessarily complicate the model. This also applies for the media parts, to which both inline and external (distributed) references should be possible (XII).

Since streaming media will become a considerable part of multimedia content, the transcoding of media to streaming media should also be possible to implement using this interface (XIII).   

It is deemed not necessary to determine requirements with respect to security and authentication issues within the context of this definition. Since the transcoding engine would normally be within the same scope as other infrastructure systems and components, security considerations would normally fall within that scope. Furthermore, authentication, if deemed necessary or is a requirement, could be effectuated at the transport layer and has thus no further bearing on this interface as such.

4. Overview

4.1 Architecture

Figure 5 provides a high level overview of the interaction between an MMSC and a Transcoding Server
.
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Figure 5
Transcoding interaction
The communication between the MMSC and the Transcoding Server is synchronized, that is, a transcoding session is always a request followed by a response (VIII)
. A session is terminated only when a response arrives. A transcoding request is posted to by the MMSC to the Transcoding Server using the protocol defined below. The Transcoding Server receives the request, parses it, handles it and generates a response to the originating MMSC.

NOTE: The open interface described in this document can be used by a variety of services to integrate with the Transcoding Server, for example, WAP gateways, i-mode gateways, e-mail servers, Unified Messaging servers and more. Throughout this document, integration with an MMSC is provided as the primary example and integration case study.

4.2 Protocol

The interface between the MMSC and the Transcoder uses SOAP 1.1 (see [1]). The SOAP content should be sent over HTTP (see [2]). The HTTP protocol should be implemented on TCP/IP.

The SOAP request will be sent as the body of a HTTP POST request (as defined in section 6.1 of [1]). The response SOAP content will be sent as a body of the HTTP POST response.

Both the request and the response will contain a single SOAP envelope, conformant with [1].

Additionally, the attachment structure is conformant to [13], but the recommended ‘start parameter’ is compulsory in this case, to permit more robust error detection.

Note that since this is the same protocol configuration as with MM7, requirements II, V and VI are covered.

Message overview

4.2.1 Request
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Figure 6
Transaction structure

Figure 6 shows an overview of the request. Multiple transcodings within a single transaction are allowed by the proposed interface and therefore this request will be referred to as Transaction. For each single Transcoding Job within a Transaction, the transcoding parameters are specified within the SOAP context. In case a Transcoding Job contains references to an attachment, those are attached inside the HTTP POST message, but outside the SOAP envelope.

Figure 7
Request structure
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Each Transcoding Job in a Transaction contains transcoding parameters as presented in Figure 7.

The interface will allow all kinds of transcodings within the supported media types (i.e. video, audio, images, rendering, and messages).

4.2.2 Response

Figure 8
Transaction structure
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The response of a Transaction is also called Transaction and can again contain several results of several Transcoding Jobs. Figure 8 illustrates the structure of a Transaction.

In this Transaction, parameters can be relevant to all targets or can be specific to a single target. For example, the duration of the entire Transcoding Job is something that is provided as parameter of the entire response and not to a specific target.

Besides specifying the targets output parameters, the interface supports reporting of statistical data gathered during the transcoding.

Figure 9
Response structure
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The Responses contained in the Transaction are detailed in Figure 9.

4.2.3  Source and Target Dependencies

The Source block of each transcoding request specifies the Source type and parameters. The Target block contains the desired Target format and parameters (or profile, see below). This way, future transcoding capabilities (such as text to speech, speech to presentation, etc.) can be easily supported without any changes to the interface definition.

4.2.4 Support for Complete Message Transcoding

Figure 10
Multimedia Message structure
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The proposed interface supports conversion and transcoding of a full message. In this case the Transcoding Server will perform the task of extracting the media elements from the message, transcoding each element and composing a new adapted message as a response. Figure 10 illustrates the structure of a Multimedia Message (MM) including the message body and all media elements.

The message body will be transferred over the interface as received by the MMSC. The media elements (including the SMIL) will be extracted from the message, go through transcoding according to the given profile, and put in a new message body, which will be returned to the MMSC, ready to be delivered (with the appropriate headers).

4.3 Message and media attachments

The data for the transcoding (either the whole message or the media parts) will be referenced from within the SOAP request (and response), and will reside either on a storage that can be accessed by the transcoding server, or attached to the message.

The proposed interface provides two methods of supporting media attachments:

· Self contained transcoding requests, in which the message elements data reside within the request itself

· External message elements, in which case the request only contains a pointer to a remote location from where the message elements can be pulled by the transcoding server

The following two sections described each of the methods.

4.3.1 External Message Elements

The SOAP request/response contains the URL pointing to the relevant files. The URL can use HTTP, FTP and FILE links.

This configuration requires the MMSC and the transcoding server to have an access to a shared persistent storage device. This storage can be either ‘local’ (shared disk or via NFS, using FILE://), or accessible via HTTP or FTP.

In this case (external media reference) the request (and response) will contain only one part, whose type will be “text/xml”.

4.3.2 Self Contained Transcoding Requests

The SOAP request/response contains references to attachments that are sent along with the message as MIME parts.

The SOAP envelope is the first part of the message, while the message elements (and/or media elements) comes as additional parts. Each part is identified by a unique ID, where the URL(s) only contains local pointer(s). See section 5.1.2 for the details.

Note that the above-described models can be mixed within one request. That is, a single request can be self-contained (in the sense of including message elements attachments) as well as contain references (URLs) to external message elements.

4.4 Profiles

A profile is a way of defining a set of related transcoding parameters. A common use of such a profile is a Terminal Profile, where the set of related parameters correspond to the capabilities of a terminal. Such a parameter set can be derived from the terminal via the User Agent Profiling (UAProf) protocol (see [15]), but currently, the set of parameters defined in UAProf is not sufficient to directly cover the full scope of transcoding requirements. Therefore, either the MMSC needs to collect the missing capabilities, or the Transcoder needs to collect them. The interface shall support both cases.

The profile doesn’t have to be terminal related – it can also be used for macro-kind of definitions, in order to define a set of variables to be used for a series of transcodings.

The proposed interface supports transcoding according to specific target parameters or according to a target profile. In order to use a predefined profile, a profile must be first defined (so it can be stored in the profiles database of the Transcoder) and then requests can include references to such profile in a transcoding request. The following sections provide an overview of the set of activities supported by the proposed interface for handling profiles
.

4.4.1 Defining a profile

In order to define a profile, a request should be sent to the transcoding server without a source. This request should contain a single set of target parameters for each supported media type. This target will be used as a default target for each media of this type when using this profile.

When using a predefined profile, the request should include its identification (ID, a string), and/or specify parameters that are different from the default.

4.4.1.1 Example – defining a “small” profile

The following example defines a profile that sets only the dimensions of an image. It can be used later in addition to the other transcoding parameters:

<ProfileID>Square_Image</ProfileID>

<Profile>

<Image>

<Width>100</Width>

<Height>100</Height>

</Image>

<Profile>

4.4.1.2 Example – defining a terminal profile

The MMSC can initiate a transcoding request that specifies a target profile using the profile name “T68i” (a terminal profile). In this case the transcoding server will have the responsibility to set the transcoding parameters that are optimized for the T68i target device. This example shows how a profile can be defined for this terminal – a default media format is set to be the target of each media type.

<ProfileID>T68i< /ProfileID>

<Profile>

<Image>

Image parameters come here

</Image>

<Audio>

Audio parameters come here

</Audio>

<Presentation>

Presentation parameters come here

</Presentation>

</Profile>

The default target for images of the profile can be GIF89a, 101x80, with level correction. When the profile is used and no parameters are specified, the defaults are used. In case a smaller image is needed, only the resolution parameters should be specified and those will then override the default resolution parameters stored in the profile database of the transcoder.

4.4.2 Modifying a profile

In order to modify a profile, the MMSC should use the definition method, and specify only the parameters that should be modified (i.e. in order to modify the dimensions of an image, there is no need to specify the audio parameters).

4.4.3 Deleting a profile

In order to delete a profile, the MMSC should use the definition method, without any parameters specified for the profile.

4.4.4 Using a predefined profile

In order to use a predefined profile, the request should specify its ID, and which targets should be used (in case none is specified, the default will be used). The profile can also be specified for the entire transaction (as a field of Transaction). In the latter case, the parameters that are specified will override the ones that are defined in the profile.

4.5 Response contents

The response will contain the output media or message (or its URL, in case it was uploaded on a streaming server), information about those files, and statistics about the transaction (e.g. duration).

5. Request 

5.1 Structure

The structure of the transcoding request differs between requests with attachments and requests without attachments. Each request contains a header, a SOAP part and a zero or more attachment parts.

The following sub-sections explain each one of the structures in details.

5.1.1 Requests without attachments

Requests that do not contain attachments (all the files are referenced using a URL) have a header and a SOAP body. The header specifies the originating host, the length, the request encoding and the SOAP action.

POST /MMSTrRequest HTTP/1.1

Host: the.host.url
Content-Type: text/xml; charset=charset
Content-Length: ###

Content-Transfer-Encoding: 8bit

SOAPAction: “/MMSTrRequest”

The character set for the XML can be either ASCII or UTF-8.

5.1.2 Requests with attachments

Requests with attachment contain the header for the request (see above) and several parts. Each part contains its own header (using MIME).

The header of the request contains, in addition to the fields that exist in the header of the attachment-less request, a string that will be the boundary between each part, as defined in MIME (see [8]).

Each part contains its unique ID, its type, its encoding (can be utf8, base64 or binary), and its length.

POST /MMSTrRequest HTTP/1.1

Host: the.host.url
Content-Type: multipart/related; boundary=<the_boundary_string>; type=text/xml; start=”<first-part>”

SOAPAction: “/MMSTrRequest”

--<the_boundary_string>

Content-Type: text/xml 

Content-ID: <first-part>

Content-Length: ###

Content-Transfer-Encoding: 8bit


SOAP comes here

--<the_boundary_string>

Content-Type: image/png

Content-ID: <image1>

Content-Length: ###

Content-Transfer-Encoding: binary


Image comes here

--<the_boundary_string>

5.2 SOAP body

The SOAP contains one envelope. Its body contains the following structure:

	Parent
	Name
	Type
	Possible Values
	Mandatory/

Optional
	Comments

	
	Transaction
	
	
	Mandatory
	Several transcoding requests can be sent within one request.

	Transaction
	TransactionID
	Integer
	
	Mandatory
	A unique ID that was given to this transaction by the MMSC.

	Transaction
	NumSubRequests
	Integer
	
	Optional
	How many sub-requests reside in this request.

This number can be 0 in case the request is a definition of a profile

	Transaction
	Priority
	Integer
	0-2
	Optional
	The priority of the requests (0 is the highest, default is 1)

	Transaction
	ProfileID
	String
	
	Optional
	The profile to be used for all the requests within this transaction

	Transaction
	Request
	
	
	Mandatory
	Each request

	Request
	Source
	
	
	Mandatory
	The source of this sub-request. When the request is a profile definition, this field should not appear

	Request
	Target
	
	
	Mandatory
	The target of this sub-request

	Source
	Type
	String
	“Message”,

“Audio”, “Image”, “Presentation”,

“Video”
	Optional
	The type of the request

	Source
	Format
	String
	According to the supported formats
	Optional
	The format (codec) of the sub-request. Not needed for a message transcoding

	Source
	Location
	String
	URL
	Mandatory
	The full-path on a shared storage or the content ID of the attachment

	Source
	AdditionalHeaders
	String
	
	Optional
	Specify additional headers needed in order to reach the media (username, cookies information, etc.)

	Target
	ProfileID
	String
	
	Optional
	A predefined profile to use or the name of a profile to define. In case no predefined profile is in use, this tag should not appear.

	Target
	Profile
	
	
	Optional
	The profile of the transcoding. This tag must appear in case a predefined profile was not specified. When a predefined profile is specified and this tag appears, the predefined values will be used as default ones, and overridden by the values specified within this tag.

	Target
	Location
	String
	URL
	Mandatory
	The full-path on a shared storage, the URL on a streaming server, or the content ID of the attachment. When it’s a profile definition, this field mustn’t appear

	Target
	AdditionalHeaders
	String
	
	Optional
	Specify additional headers needed in order to reach the media (username, cookies information, etc.)

	Profile
	SizeLimit
	Integer
	
	Optional
	The limit of the file sizes for the entire transaction. Default is unlimited (-1)

	Profile
	Audio
	
	
	Optional
	The audio transcoding parameters.

	Profile
	Image
	
	
	Optional
	The image transcoding parameters.

	Profile
	Presentation
	
	
	Optional
	The Presentation transcoding parameters (such as SMIL).

	Profile
	Video
	
	
	Optional
	The video transcoding parameters.

	Audio
	FileFormat
	String
	According to the supported audio formats
	Optional
	The file-format of the target. Any supported audio

	Audio
	Codec
	String
	According to the supported audio codecs
	Optional
	The desired codec. Restricted by the file format

	Audio
	BitRate
	Integer
	
	Optional
	The desired bit-rate. Restricted by the codec

	Audio
	Channels
	String
	“Mono”, “Stereo”, “DualMono”, “IntensityStereo”
	Optional
	The desired channel mode. Restricted by the codec

	Audio
	Duration
	Integer
	
	Optional
	Default is unlimited (-1)

	Audio
	SamplingRate
	Integer
	
	Optional
	The desired sampling rate. Restricted by the codec

	Audio
	SamplingResolution
	Integer
	
	Optional
	The desired sampling resolution. Restricted by the codec

	Audio
	SizeLimit
	Integer
	
	Optional
	The limit of the file size for an audio. Default is unlimited (-1)

	Image
	Format
	String
	According to the supported image formats
	Optional
	The format of the target. Any supported image

	Image
	ColorScheme
	String
	“True24Bit”, “True12Bit”, “Palette256Co”, “Palette256Gr”, “Palette32Co”, “Palette32Gr”, “Palette16Co”, “Pallete16Gr”, “Palette4Co”, “Palette4Gr”, “1Bit”
	Optional
	The desired color scheme

	Image
	Width
	Integer
	
	Optional
	The target width

	Image
	Height
	Integer
	
	Optional
	The target height

	Image
	ResizePolicy
	String
	“AspectRatio”, “Crop”, “None”
	Optional
	Maintain the aspect ratio when resizing (the new dimensions are set to fit into the desired width while aspect ratio is maintained), crop when shrinking (do not scale the image – take its central rectangle), or just stretch.

	Image
	SizeLimit
	Integer
	
	Optional
	Default is unlimited (-1)

	Image
	Transformations
	
	
	Optional
	The transformations that the image should go through

	Transformations
	LevelCorrection
	Boolean
	
	Optional
	Default is false

	Transformations
	Mirror
	String
	“UD”, “LR, “Diagonal”, “None”
	Optional
	“UD” - vertical mirror, “LR” - horizontal mirror. Default is “None”

	Transformations
	NoiseReduction
	Boolean
	
	Optional
	Default is false

	Transformations
	Rotation
	Integer
	0-359
	Optional
	Default is 0

	Transformations
	Sharpen
	Boolean
	
	Optional
	Default is false

	Presentation
	Width
	Integer
	
	Optional
	Target width

	Presentation
	Height
	Integer
	
	Optional
	Target height

	Presentation
	Layout
	String
	“Portrait”, “Landscape”
	Optional
	In case this parameter is not provided original Layout is maintained.

	Presentation
	SizeLimit
	Integer
	
	Optional
	Default is unlimited (-1)

	Video
	Format
	String
	According to the supported video formats
	Optional
	The format of the target. Any supported video

	Video
	Width
	Integer
	
	Optional
	Target width

	Video
	Height
	Integer
	
	Optional
	Target height

	Video
	Duration
	Integer
	
	Optional
	Target duration (milliseconds). Default is unlimited (-1)

	Video
	FrameRate
	Integer
	
	Optional
	The wanted target frame rate

	Video
	BitRate
	Integer
	
	Optional
	The desired target bit rate

	Video
	SizeLimit
	Integer
	
	Optional
	Default is unlimited (-1)


Notes:

1. Since a predefined profile can be specified, all the profile related tags are optional. Note that at least one of ProfileID and a valid Profile (with all the needed information for the transcoding) is mandatory.

2. The structures are written in bold.

6. Response

6.1 Success response – structure

The structure of a successful transcoding’s response is quite similar to the request – a header, and one or more parts with the response.

The header will include a success code (200), and data about the response body:

HTTP/1.1 200 OK

Content-Type: text/xml; charset=charset
Content-length: ###

The same differences between a single part and multi part requests apply for responses.

6.2 Success response – SOAP body

The body of the response contains the following structure:

	Parent
	Name
	Type
	Possible Values
	Comments

	
	Transaction
	
	
	The response

	Transaction
	NumSubResponses
	Integer
	
	How many sub-responses reside in this response. 0 in case it’s a definition of a profile

	Transaction
	ProfileID
	String
	
	The profile ID that was used for this transaction (in case it was specified in the Transaction block of the request)

	Transaction
	TransactionID
	Integer
	
	The unique ID that was received from the MMSC in the request

	Transaction
	ContextID
	Integer
	
	A unique ID of the transcoding session that is given by the transcoding server. Not mandatory for profile definitions

	Transaction
	TotalDuration
	Integer
	
	The time it took the transcoding server to perform the entire transcoding Transaction in milliseconds. This number is the duration of the whole request from the time it reached the server to the time the response was sent (it can be higher or lower than the sum of durations for each sub-request). Not mandatory for profile definitions

	Transaction
	Response
	
	
	The sub-responses. May be more than one

	Response
	ReturnCode
	Integer
	
	The return code of the transcoding (either a successful or a warning)

	Response
	Message
	String
	
	A message with an explanation in case of a warning

	Response
	Duration
	Integer
	
	The duration it took this media transcoding (in milliseconds)

	Response
	Target
	
	
	Details about the target. This tag should not appear in case it’s a response of profile definition

	Target
	FileSize
	Integer
	
	The actual size of the file

	Target
	Location
	String
	
	The path on the storage, the URL on the streaming server, or the content ID of the attachment

	Target
	Profile
	
	
	The profile of the output file

	Profile
	ProfileID
	String
	
	In case a pre-defined profile was used – specify it here. Optional

	Profile
	SizeLimit
	Integer
	
	The limit that was given to the entire transaction

	Profile
	Audio
	
	
	Audio details

	Profile
	Image
	
	
	Image details

	Profile
	Presentation
	
	
	Presentation (e.g., SMIL) details

	Profile
	Video
	
	
	Video details

	Audio
	FileFormat
	String
	The supported audio formats
	The file format

	Audio
	Codec
	String
	The supported audio codecs
	The codec

	Audio
	BitRate
	Integer
	
	The bit-rate

	Audio
	Channels
	String
	“Mono”, “Stereo”, “DualMono”, “IntensityStereo”
	The channel mode (“Mono”, “Stereo”, or “DualMono”)

	Audio
	Duration
	Integer
	
	Audio duration

	Audio
	SamplingRate
	Integer
	
	The sampling rate

	Audio
	SamplingResolution
	Integer
	
	The sampling resolution

	Audio
	SizeLimit
	Integer
	
	The limit that was given for an audio

	Image
	Format
	String
	The supported image formats
	The format

	Image
	ColorScheme
	String
	“True24Bit”, “True12Bit”, “Palette256Co”, “Palette256Gr”, “Palette32Co”, “Palette32Gr”, “Palette16Co”, “Pallete16Gr”, “Palette4Co”, “Palette4Gr”, “1Bit”
	The color scheme of the image

	Image
	NunberOfColors
	Integer
	
	The actual number of colors

	Image
	Width
	Integer
	
	The width

	Image
	Height
	Integer
	
	The height

	Image
	SizeLimit
	Integer
	
	The limit that was given for an image

	Image
	Transformations
	
	
	The transformations that the image went through

	Transformations
	LevelCorrection
	Boolean
	
	

	Transformations
	Mirror
	String
	“UD”, “LR”, “Diagonal”, “None”
	

	Transformations
	NoiseReduction
	Boolean
	
	

	Transformations
	Rotation
	0-359
	
	

	Transformations
	Sharpen
	Boolean
	
	

	Presentation
	Width
	Integer
	
	The width

	Presentation
	Height
	Integer
	
	The height

	Presentation
	SizeLimit
	Integer
	
	The limit that was given for a presentation

	Video
	Format
	String
	The supported video formats
	The format

	Video
	Width
	Integer
	
	The width

	Video
	Height
	Integer
	
	The height

	Video
	Duration
	Integer
	
	Duration in milliseconds

	Video
	FrameRate
	Integer
	
	The frame rate

	Video
	SizeLimit
	Integer
	
	The limit that was given for a video


6.3 Failure response – structure

The header of a transcoding error contains a line that indicates that there was an error (HTTP/1.1 500 Error), and the regular fields. The body of the SOAP is of a different structure from a successful one.

HTTP/1.1 500 ERROR

Content-Type: text/xml; charset=charset
Content-length: ###

6.4 Failure response – SOAP body

	Parent
	Name
	Type
	Possible Values
	Description

	
	FaultResponse
	
	
	The fault

	FaultResponse
	TransactionID
	Integer
	
	The unique ID that was received from the MMSC in the request

	FaultResponse
	ContextID
	Integer
	
	A unique ID of the transcoding session that is given by the transcoding server. Not mandatory for profile definitions

	FaultResponse
	TotalDuration
	Integer
	
	The total milliseconds it took the whole request to be transcoded (until the error occurred)

	FaultResponse
	ReturnCode
	Integer
	Out of the possible error codes
	

	FaultResponse
	Message
	String
	
	An explanatory error message


6.5 Error codes

The transcoding server supports the following error codes:

	Error code
	Error string

	1001
	Parsing error

	1002
	Transcoder activation failure

	1003
	Timeout waiting for transcoder response

	1004
	Erroneous target structure

	1005
	Error in target data

	1006
	General server error

	1007
	Input command exceeds maximal size

	1008
	No media detected in request message

	1009
	Response composition error (<err-code>)

	2001
	Error in command parameters

	2002
	Error in input media

	2003
	Processing error

	2004
	Unsupported media

	2005
	Number of concurrent requests exceeded

	2006
	Unsupported transcoding request

	2007
	Erroneous transcoding request

	2008
	Transcoding initialization failure

	2009
	No media detected in request message

	2010
	Media result exceeds maximal size

	2011
	Transaction result exceed maximal size

	3001
	Resources not available

	3002
	Request type not supported

	3003
	Resource activation refused

	3004
	General timeout

	3005
	Internal resource activation failure

	3006
	Request syntax error


ANNEX A – Normative Examples

A.1 Request

<?xml version="1.0" encoding="UTF-8"?>

<env:Envelope xmlns:env=http://schemas.xmlsoap.org/soap/envelope/>

<env:Body>
<mt:Transcode xmlns:mt="//www.3gpp.org/MMS/Rel6/MMST">

<Transaction>

<TransactionID>

<! The ID that is given to the transaction by the MMSC/>

<TransactionID>

<NumSubRequests>

<! The number of sub-request within this transaction. Optional when 1 />

</NumSubRequests>

<Priority>

<! The priority of this transaction (0, 1 or 2) />

</Priority>

<ProfileID>

<! The profile to be used for the entire transaction />

</ProfileID>

<Request>

<Source>

<Type>

<! The type of the request (audio, image, presentation, video) />

</Type>

<Format>

<! The format of the source />

</Format>

<Location>

<! The URL of the source file />

</Location>

<AdditionalHeaders>

<! Additional headers needed to access the source file />

</AdditionalHeaders>

</Source>

<Target>

<ProfileID>

<! The profile to be used for this request />

</ProfileID>

<Profile>

<SizeLimit>

<! The limit of the entire request />

</SizeLimit>

<Audio>

<FileFormat>

<! The format to transcode to />

</FileFormat>

<Codec>

<! The codec to transcode to />

</Codec>

<Bitrate>

<! The bitrate to transcode to />

</Bitrate>

<Channels>

<! The channels to transcode to (Mono, Stereo, DualMono or IntensityStereo) />

</Channels>

<Duration>

<! The maximum duration allowed for this audio />

</Duration>

<SamplingRate>

<! The sampling rate to transcode to />

</SamplingRate>

<SamplingResolution>

<! The sampling resolution to transcode to />

</SamplingResolution>

<SizeLimit>

<! The maximum size allowed for the audio/>

</SizeLimit>

</Audio>

<Image>

<Format>

<! The format to transcode to />

</Format>

<ColorScheme>

<! The color scheme to transcode to />

</ColorScheme>

<Width>

<! The width of the target image />

</Width>

<Height>

<! The height of the target image />

</Height>

<ResizePolicy>

<! The resize policy (AspectRatio, Crop or None) />

</ResizePolicy>

<SizeLimit>

<! The maximum size allowed for this image />

</SizeLimit>

<Transformations>

<LevelCorrection>

<! Should level correction algorithm be used />

</LevelCorrection>

<Mirror>

<! Which mirror to apply on the target (UD, LR, Diagonal, None) />

</Mirror>

<NoiseReduction>

<! Should noise reduction algorithm be used />

</NoiseReduction>

<Rotation>

<! Which rotation should be used (0-359, clockwise) />

</Rotation>

<Sharpen>

<! Should a sharpen algorithm be used />

</Sharpen>

</Transformations>

</Image>

<Presentation>

<Width>

<! The width of the target presentation />

</Width>

<Height>

<! The height of the target presentation />

</Height>

<Layout>

<! The layout of the target presentation (Portrait, Landscape). The original layout is maintained in case none is specified />

</Layout>

<SizeLimit>

<! The maximum size allowed for the presentation/>

</SizeLimit>

</Presentation>

<Video>

<Format>

<! The format to transcode to />

</Format>

<Width>

<! The width of the target video />

</Width>

<Height>

<! The height of the target video />

</Height>

<Duration>

<! The maximum duration allowed for the output video />

</Duration>

<FrameRate>

<! The frame rate of the target video />

</FrameRate>

<BitRate>

<! The bit rate of the target video />

</BitRate>

<SizeLimit>

<! The maximum size allowed for the video />

</SizeLimit>

</Video>

</Profile>

<Location>

<! The URL of the target />

</Location>

<AdditionalHeaders>

<! Additional headers needed in order to access the target file />

</AdditionalHeaders>

</Target>

</Request>

</Transaction>

</mt:Transcode>

</env:Body>

</env:Envelope>

A.2 Successful response

<?xml version="1.0" encoding="UTF-8"?>

<env:Envelope xmlns:env=http://schemas.xmlsoap.org/soap/envelope/>

<env:Body>
<Transaction>

<NumSubResponses>

<! The number of sub responses in this transaction />

</NumSubResponses>

<ProfileID>

<! The profile that was used for this transaction />

</ProfileID>

<TransactionID>

<! The transaction ID, given by the MMSC />

</TransactionID>

<ContextID>

<! The context ID, given by the MMSC />

</ContextID>

<TotalDuration>

<! The total duration of the transaction />

</TotalDuration>

<Response>

<ReturnCode>

<! The return code of this transcoding (0 means success) />

</ReturnCode>

<Message>

<! A warning message, if needed />

</Message>

<Duration>

<! The transcoding duration of the current response />

</Duration>

<Target>

<FileSize>

<! The size of the target file />

</FileSize>

<Location>

<! The URL of the target file />

</Location>

<Profile>

<ProfileID>

<! The profile that was used />

</ProfileID>

<SizeLimit>

<! The size limit that was received />

</SizeLimit>

<Audio>

<FileFormat>

<! The format of the target />

</FileFormat>

<Codec>

<! The codec of the target />

</Codec>

<Bitrate>

<! The bitrate of the target />

</Bitrate>

<Channels>

<! The channels of the target (Mono, Stereo, DualMono or IntensityStereo) />

</Channels>

<Duration>

<! The duration that was allowed for this audio />

</Duration>

<SamplingRate>

<! The sampling rate of the target />

</SamplingRate>

<SamplingResolution>

<! The sampling resolution of the target />

</SamplingResolution>

<SizeLimit>

<! The maximum size allowed for the audio/>

</SizeLimit>

</Audio>

<Image>

<Format>

<! The format of the target />

</Format>

<ColorScheme>

<! The color scheme of the target />

</ColorScheme>

<NumberOfColors>

<! The number of actual colors in the target image />

</NumberOfColors>

<Width>

<! The width of the target image />

</Width>

<Height>

<! The height of the target image />

</Height>

<SizeLimit>

<! The maximum size allowed for this image />

</SizeLimit>

<Transformations>

<LevelCorrection>

<! Was level correction algorithm used />

</LevelCorrection>

<Mirror>

<! Which mirror was applied on the target (UD, LR, Diagonal, None) />

</Mirror>

<NoiseReduction>

<! Was noise reduction algorithm used />

</NoiseReduction>

<Rotation>

<! Which rotation was used (0-359, clockwise) />

</Rotation>

<Sharpen>

<! Was a sharpen algorithm used />

</Sharpen>

</Transformations>

</Image>

<Presentation>

<Width>

<! The width of the target presentation />

</Width>

<Height>

<! The height of the target presentation />

</Height>

<SizeLimit>

<! The maximum size allowed for the presentation/>

</SizeLimit>

</Presentation>

<Video>

<Format>

<! The format of the target video />

</Format>

<Width>

<! The width of the target video />

</Width>

<Height>

<! The height of the target video />

</Height>

<Duration>

<! The maximum duration allowed for the target video />

</Duration>

<FrameRate>

<! The frame rate of the target video />

</FrameRate>

<SizeLimit>

<! The maximum size allowed for the video />

</SizeLimit>

</Video>

</Profile>

</Target>

</Response>

</Transaction>

</env:Body>

</env:Envelope>

A.3 Acknowledgment

<?xml version="1.0" encoding="UTF-8"?>

<env:Envelope xmlns:env=http://schemas.xmlsoap.org/soap/envelope/>

<env:Body>
<Acknowledgment>

<TransactionID>

<! The transaction ID, given by the MMSC />

</TransactionID>

<ContextID>

<! The context ID, given by the transcoding server />

</ContextID>

</ Acknowledgment >

</env:Body>

</env:Envelope>

A.4 Fault response

<?xml version="1.0" encoding="UTF-8"?>

<env:Envelope xmlns:env=http://schemas.xmlsoap.org/soap/envelope/>

<env:Body>
<FaultResponse>

<TransactionID>

<! The transaction ID, given by the MMSC />

</ TransactionID >

<ContextID>

<! The context ID, given by the transcoding server />

</ContextID>

<TotalDuration>

<! The total duration until the error />

</TotalDuration>

<ReturnCode>

<! The error code />

</ReturnCode>

<Mesasge>

<! The error message />

 </Message>

</FaultResponse>

</env:Body>

</env:Envelope>

Annex B – Requests (informative examples)

B.1 Message request

POST /MMSTrRequest HTTP/1.1

Host: mmsc.host.com:80

Content-Type: text/xml; charset=”utf-8”

Content-Length: ###

Content-Transfer-Encoding: 8bit
SOAPAction: "/MMSTrRequest"

<?xml version="1.0" encoding="UTF-8"?>

<env:Envelope xmlns:env=http://schemas.xmlsoap.org/soap/envelope/>

<env:Body>
<mt:Transcode xmlns:mt="//www.3gpp.org/MMS/Rel6/MMST">

<Transaction>

<TransactionID>465156321</TransactionID>

<ProfileID>Nokia7650</ProfileID>

<Request>

<Source>

<Type>Message</Type>


<Location>FILE://disks/disk0/input/msg184.msg</Location>


</Source>

<Target>

<Profile>

<Image>

<Format>JPEG</Format>

<Transformations>

<LevelCorrection>False</LevelCorrection>

</Transformations>

</Image>

</Profile>

<Location>FILE://disks/disk0/output/msg184_7650</Location>

</Target>

</Request>

</Transaction>

</mt:Transcode>

</env:Body>

</env:Envelope>

B.2 Request for image, audio and SMIL transcoding using different options

The following example contains a transaction with three requests – one image, with a specified profile, one SMIL, which uses a predefined profile, and one audio, which uses a predefined profile, but overrides the bit-rate.

POST /MMSTrRequest HTTP/1.1

Host: mmsc.host.com:80

Content-Type: multipart/related; boundary=<boundary_string>; type=text/xml; start=”<soap-part>”

SOAPAction: "/MMSTrRequest"

--<boundary_string>

Content-Type: type=text/xml; charset=”utf-8”

Content-Length: ###

Content-Id: ”<soap-part>”

Content-Transfer-Encoding: 8bit

<?xml version="1.0" encoding="UTF-8"?>

<env:Envelope xmlns:env=http://schemas.xmlsoap.org/soap/envelope/>

<env:Body>
<mt:Transcode xmlns:mt="//www.3gpp.org/MMS/Rel6/MMST">

<Transaction>

<TransactionID>654164615</TransactionID>

<NumSubRequests>3</NumSubRequests>

<Priority>0</Priority>

<Request>

<Source>

<Type>Image</Type>

<Format>GIF89A</Format>

<Location>cid:image1.gif</Location>


</Source>

<Target>

<Profile>

<SizeLimit>30000</SizeLimit>

<Image>

<Format>JPEG</Format>

<ColorScheme>True24Bit </ColorScheme>

<Width>101>/Width>

<Height>80</Height>

<ResizePolicy>AspectRatio</ResizePolicy>

<Transformations>

<NoiseReduction>True</NoiseReduction>

</Transformations>

</Image>

</Profile>

<Location>cid:image1res.jpg</Location>

</Target>

</Request>

<Request>

<Source>

<Type>Audio</Type>

<Format>PCMWav</Format>

<Location>FILE://disks/disk0/input/aud252.wav</Location>

</Source>

<Target>

<ProfileID>T68i_goodquality</ProfileID>

<Profile>

<Audio>

<BitRate>12200</BitRate>

</Audio>

</Profile>

<Location>cid:audio1res.amr</Location>

</Target>

</Request>

<Request>

<Source>

<Type>Presentation</Type>

<Format>SMIL</Format>

<Location>cid:smil1.smi</Location>

</Source>

<Target>

<ProfileID>T68i_goodquality</ProfileID>

<Location>cid:smil1res.smi</Location>

</Target>

</Request>

</Transaction>

</mt:Transcode>

</env:Body>

</env:Envelope>

--<boundary_string>

Content-Type: type=image/gif; encoding=binary

Content-Length: 15435

Content-Id: ”image1.gif”

Image comes here

--<boundary_string>

Content-Type: type=text/xml; encoding=8bit

Content-Length: 124

Content-Id: ”smil1.smi”

SMIL comes here

--<boundary_string>

B.3 Defining a profile

POST /MMSTrRequest HTTP/1.1

Host: mmsc.host.com:80

Content-Type: text/xml; charset=”utf-8”

Content-Length: ###

Content-Transfer-Encoding: 8bit
SOAPAction: "/MMSTrRequest"

<?xml version="1.0" encoding="UTF-8"?>

<env:Envelope xmlns:env=http://schemas.xmlsoap.org/soap/envelope/>

<env:Body>
<mt:Transcode xmlns:mt="//www.3gpp.org/MMS/Rel6/MMST">

<Transaction>

<TransactionID>8416521</TransactionID>

<NumSubRequests>1</NumSubRequests>

<Request>

<Target>

<ProfileID>T68i_goodquality</ProfileID>

<Profile>

<SizeLimit>51200</SizeLimit>

<Audio>

<FileFormat>amr</FileFormat>

< Codec>AMRNB</Codec>

<Bitrate>4800</Bitrate>

<Channels>Mono</Channels>

<Duration>40000</Duration>

<SamplingRate>8000</SamplingRate>

<SamplingResolution>8</SamplingResolution>

<SizeLimit>40000</SizeLimit>

</Audio>

<Image>

<Format>GIF89A</Format>

<ColorScheme>Palette256Co</ColorScheme>

<Width>101</Width>

<Height>80</Height>

<SizeLimit>30000</SizeLimit>

<Transformations>

<LevelCorrection>True</LevelCorrection>

</Transformations>

</Image>

<Presentation>

<Width>101</Width>

<Height>80</Height>

</Presentation>

</Profile>

</Target>

</Request>

</Transaction>

</mt:Transcode>

</env:Body>

</env:Envelope>

Annex C – Responses (informative examples)

C.1 Response with image and audio

HTTP/1.1 200 OK

Content-Type: multipart/related; boundary=”<boundary_string>"; type=text/xml; start=”<soap-part>”

--<boundary_string>
Content-Type: type=text/xml; charset=”utf-8”

Content-Length: ###

Content-Id: ”<soap-part>”

Content-Transfer-Encoding: 8bit

<?xml version="1.0" encoding="UTF-8"?>

<env:Envelope xmlns:env=http://schemas.xmlsoap.org/soap/envelope/>

<env:Body>
<Transaction>

<TransactionID>41352563</TransactionID>

<ContextID>5461415611</ContextID>

<NumSubResponses>2</NumSubResponses>

<TotalDuration>647</TotalDuration>

<Response>

<ReturnCode>0</ReturnCode>

<Duration>78</Duration>

<Target>

<FileSize>15478</FileSize>

<Location>cid:image1res.gif</Location>

<Profile>

<Image>

<Format>GIF89A</Format>

<ColorScheme>Palette256Co</ColorScheme>

<NumberOfColors>213</NumberOfColors>

<Width>96</Width>

<Height>72</Height>

<Transformations>

<Mirror>LR</Mirror>

<NoiseReduction>True</NoiseReduction>

</Transformations>

</Image>

</Profile>

</Target>

</Response>

<Response>

<ReturnCode>1</ReturnCode>

<Message>Duration was truncated to 25000ms</Message>

<Duration>509</Duration>

<Target>

<FileSize>19458</FileSize>

<Location>cid:audio1res.amr</Location>

<Profile>

<ProfileID>T68i_goodquality</ProfileID>

<Audio>

<FileFormat>amr</FileFormat>

<Codec>AMR-NB</Codec>

<Bitrate>7400</Bitrate>

<Channels>Mono</Channels>

<Duration>25000</Duration>

<SamplingRate>8000</SamplingRate>

</Audio>

</Profile>

</Target>

</Response>

</Transaction>

</env:Body>

</env:Envelope>

--<boundary_string>
Content-Type: type=image/gif; encoding=binary

Content-Length: 15478

Content-Id: ”image1res.gif”

Image comes here

--<boundary_string>
Content-Type: type=audio/amr; encoding=binary

Content-Length: 19458

Content-Id: ”audio1res.amr”

Audio comes here

--<boundary_string>
C.2 Response for failures

HTTP/1.1 500 Error

Content-Type: type=text/xml; charset=”utf-8”

Content-Transfer-Encoding: 8bit

Content-Length: ###

<?xml version="1.0" encoding="UTF-8"?>

<env:Envelope xmlns:env=http://schemas.xmlsoap.org/soap/envelope/>

<env:Body>
< FaultResponse>

<TransactionID>1234567</ TransactionID >

<ContextID>9876542</ContextID>

<TotalDuration>35</TotalDuration>

<ReturnCode>1001</ReturnCode>

<Mesasge>Parsing error</Message>

</FaultResponse>

</env:Body>

</env:Envelope>

C.3 Response for profile definition

HTTP/1.1 200 OK

Content-Type: type=text/xml; charset=”utf-8”

Content-Length: ###

Content-Transfer-Encoding: 8bit

<?xml version="1.0" encoding="UTF-8"?>

<env:Envelope xmlns:env=http://schemas.xmlsoap.org/soap/envelope/>

<env:Body>
<Transaction>

<NumSubResponses>1</NumSubResponses>

<TransactionID>416513</TransactionID>

<ContextID>48559862</ContextID>

<TotalDuration>12</TotalDuration>

<Response>

<ReturnCode>0</ReturnCode>

<Message>Profile was added</Message>

<Duration>10</Duration>

</Response>

</Transaction>

</env:Body>

</env:Envelope>

C.4 Acknowledgment response

HTTP/1.1 200 OK

Content-Type: type=text/xml; charset=”utf-8”

Content-Length: ###

Content-Transfer-Encoding: 8bit

<?xml version="1.0" encoding="UTF-8"?>

<env:Envelope xmlns:env=http://schemas.xmlsoap.org/soap/envelope/>

<env:Body>
<Acknowledgment>

<TransactionID>416513</TransactionID>

<ContextID>48559862</ContextID>

</ Acknowledgment >

</env:Body>

</env:Envelope>
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� For this kind of figures, the Unified Modeling Language (UML) is used


� This notation is used as referral to previously defined requirements, see page � PAGEREF _Ref16045084 \h ��10�


� Note that the Transcoder may also support other ways to create, modify and remove profiles, for example via a web-based interface or configuration files. This management of profiles is outside of the scope of this document.
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